
Antena horn piramidala si
antena horn circulara



Enunțul lucrării

• Să se modeleze și analizeze o antenă  de tip 
horn piramidală folosind Ansoft HFSS.



Enunțul lucrării

https://www.everythingrf.com/tech-resources/waveguides-sizes/wr62

https://www.compeng.com.au/document-library/standard-gain-horn-
antennas/?fbclid=IwAR0loKoFoypstXakwg_gW4EIpcUfnHMGirJAQC6RhraZW
Cvn1u0LBiqfMlA



Obiectivele lucrării

• Modelarea unei antene horn  piramidale

• Determinarea câștigului ca polar plot

• Determinarea radiației rE ca polar plot

• Reprezentarea parametrilor S

• Determinarea distributiei de camp electric pe planul XY

• Determinarea distributiei de camp electric pe planul YZ

• Determinarea distributiei de camp magnetic pe planul XY

• Determinarea distributiei de camp magnetic pe planul YZ

• Reprezentarea radiatiei



Implementarea modelului pentru modelare numerică 

• Se deschide Ansys Electronics Desktop 

• Se va alege să se modeleze un proiect HFSS



Implementarea modelului pentru modelare numerică 

• Vom alege unitatea de măsură pentru model din Modeler ->Units…

• Vom alege tipul soluției din HFSS->Solution Type



• Desenăm un box, după cum urmează:

Implementarea antenei de tip horn
Desenarea ghidului de undă



Implementarea antenei de tip horn
Desenarea deschiderii hornului

• Se va desena un dreptunghi în planul YZ reprezentând deschiderea 
antenei



Implementarea antenei de tip horn
Desenarea deschiderii hornului

• Se va selecta Edit-> Select Faces si se va alege aceasta fata

• Se va accesa Modeler->Surface->Create object from face



Implementarea antenei de tip horn
Desenarea deschiderii hornului

• Se va trece la selection mode la modul de selectie object 

• Se selecteaza noul element creat si dreptunghiul creat pentru 
deschidere si se va selecta modeler->surface ->connect

• Se selecteaza toate obiectele create in acest model si se va da 
Modeler ->Boolean->Unite



• Pentru a vedea lista de variabile fie accesam HFSS->design 
properties

• Fie mergem pe design in project manager si se deschide in fereastra 
de Properties o lista cu acestea; astfel valorile pot fi modificate in 
orice moment al modelarii

Observarea parametrilor modelului



Crearea stratului de metal

• Vom trece iar la tipul de selectie fețe deci Edit->Selection Mode-
>Faces

• Edit->Select objects->By Name permite selectarea specifica a fetelor; 
vom allege toate fetele, excluzand doar cea mai mare dintre ele si 
anume cea de la iesire din Horn



• Cu suprafetele selectate, vom apela Modeler->Surface->Create Object 
From Face

• Modeler->Boolean ->Unite va creea din toate fetele nou create un 
nou element

• Modeler->Surface->Thicken Sheet va permite introducerea unei noi 
grosimi

Crearea stratului de metal



Implementarea antenei de tip horn
Atribuirea materialelor

aer

cupru



Crearea unei regiuni

Se va alege optiunea de  
Absolute Offset, apoi se va 
introduce  valoarea 12.7 mm

Pentru a modifica ulterior 
valoarea din fata antenei se va 
da dublu click pe regiune si 
modificam la –x Padding Data 
valoarea la 100 mm



Implementarea antenei de tip horn
Desenarea unui dreptunghi care va servi ca port



Atribuirea surselor și a condițiilor de frontieră

• Se va selecta o condiție de frontieră de tip Radiation pe regiunea definită 
Assign Boundary ->Radiation



Atribuirea surselor și a condițiilor de frontieră

• Se va selecta acel dreptunghi pe care l-am desenat anterior și se va apela 
Assign Excitation  ->Waveport…dam next peste tot



Setarea parametrilor care se doresc a fi determinați în cadrul
lucrării

• Se vor impune setările de rulare/rezolvare/soluționare 

• Se vor rula numeric problema modelată



Setarea parametrilor care se doresc a fi determinați în cadrul lucrării
Crearea unei sfere de radiație



Culegerea, interpretarea și postprocesarea rezultatelor



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea parametrilor S



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea parametrilor S

În ce domeniu funcționează antena?



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea radiației



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea radiației (rE)

Realizați reprezentarea când apare și antena
Reprezentați și directivitatea



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea castigului

Realizați reprezentarea când apare și antena
Reprezentați și câștigul și directivitatea



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea castigului 2D

• Results->Create Far Field Report->Rectangular Plot



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea castigului 2D

Realizați reprezentarea de mai sus doar pentru phi =0,46 si 90. Care este valoare maxima a directivitatii?



Culegerea, interpretarea și postprocesarea rezultatelor
Reprezentați distribuția de câmp electric in planul XY

• Alegem planul din Planes, apoi click dreapta pe planul de 
lucru Plot Fields->E->Mag E

Animati



Culegerea, interpretarea și postprocesarea rezultatelor
Reprezentați distribuția de câmp electric in planul XZ



Culegerea, interpretarea și postprocesarea rezultatelor
Reprezentați distribuția de câmp magnetic in planul XY

• Alegem planul din Planes, apoi click dreapta pe planul de 
lucru Plot Fields->E->Mag H



Culegerea, interpretarea și postprocesarea rezultatelor
Reprezentați distribuția de câmp magnetic in planul XZ

Exista diferente de valori in cele 2 reprezentari pe planuri diferite?



Aplicații

• Reprezentați VSWR

• Reprezentati si meshul modelului

Temă Modificați dimensiunile Hornului astfel incat sa obtineti o antena sectoriala de plan H sau de 
plan E si urmariti modificarile aparute in parametrii de interes



Antena horn circulara



Enunțul lucrării 

• Să se modeleze și analizeze o antenă  de tip 
horn circulara folosind Ansoft HFSS.



Enunțul lucrării

https://manualzz.com/doc/29697004/circular-and-rectangular-horn-antennas

https://www.amtechs.co.jp/maker/b63c7cf9f3aad6acec500872e00f3244310977d7.pdf



Obiectivele lucrării

• Modelarea unei antene horn  circulare

Determinarea câștigului ca polar plot
Determinarea radiației rE ca polar plot
Reprezentarea parametrilor S
Determinarea distributiei de camp electric pe planul XY
Determinarea distributiei de camp electric pe planul YZ
Determinarea distributiei de camp magnetic pe planul XY
Determinarea distributiei de camp magnetic pe planul YZ
Reprezentarea radiatiei



Implementarea modelului pentru modelare numerică 

• Se deschide Ansys Electronics Desktop 

• Se va alege să se modeleze un proiect HFSS



Implementarea modelului pentru modelare numerică 

• Vom alege unitatea de măsură pentru model din Modeler ->Units…

• Vom alege tipul soluției din HFSS->Solution Type



• Vom orienta planul de lucru in urmatorul mod 

Implementarea antenei de tip horn
Desenarea ghidului de undă

• Desenăm o linie si profitam de posibilitatea de a creea o geometrie 
bazata pe simetrie, astfel alegem Draw->Line

• Vpm creea o linie cu primul punct in 0, apoi inca 3 puncte ca in 
imagine



Implementarea antenei de tip horn
Desenarea ghidului de undă

• Urmatorul pas va fi selectarea polyline-ului si  crearea obiectului din 
el cu ajutorul comenzii Draw-> sweep around axis sau cu click pe 



• Vom face peretele de conductor mai gros selectand geometria si din 
Modeler->Surface->Thicken Sheet… ii dam o grosime de 1.524 mm

Implementarea antenei de tip horn
Desenarea ghidului de undă

• Materialul ales pentru structura va fi aluminiu ; structura va fi numita horn si va avea culoarea gri



Implementarea antenei de tip horn
Desenarea unui cerc ce va servi ca port



Atribuirea surselor și a condițiilor de frontieră

• Se va selecta o condiție de frontieră de tip Radiation pe regiunea definită 
Assign Boundary ->Radiation pe regiune



Atribuirea surselor și a condițiilor de frontieră

• Se va selecta acel cerc pe care l-am desenat anterior și se va apela Assign 
Excitation  ->Waveport…dam next peste tot



Setarea parametrilor care se doresc a fi determinați în cadrul
lucrării

• Se vor impune setările de rulare/rezolvare/soluționare 

• Se vor rula numeric problema modelată



Setarea parametrilor care se doresc a fi determinați în cadrul lucrării
Crearea unei sfere de radiație



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea parametrilor S



Culegerea, interpretarea și postprocesarea rezultatelor 
Reprezentarea castigului





Bibliografie

https://www.youtube.com/watch?v=0w3cvOHYdiA

https://www.youtube.com/watch?v=4gyM1RHj6Sk

https://www.ets-lindgren.com/get-manuals/3160(1).pdf

https://hrcak.srce.hr/file/203404

https://manualzz.com/doc/29697004/circular-and-rectangular-horn-antennas

https://www.youtube.com/watch?v=MjqXvERSQXg


	Slide 1
	Slide 2:  Enunțul lucrării  
	Slide 3:  Enunțul lucrării  
	Slide 4:  Obiectivele lucrării   
	Slide 5: Implementarea modelului pentru modelare numerică 
	Slide 6: Implementarea modelului pentru modelare numerică 
	Slide 7: Implementarea antenei de tip horn Desenarea ghidului de undă
	Slide 8: Implementarea antenei de tip horn Desenarea deschiderii hornului
	Slide 9: Implementarea antenei de tip horn Desenarea deschiderii hornului
	Slide 10: Implementarea antenei de tip horn Desenarea deschiderii hornului
	Slide 11
	Slide 12: Crearea stratului de metal
	Slide 13
	Slide 14: Implementarea antenei de tip horn Atribuirea materialelor
	Slide 15: Crearea unei regiuni
	Slide 16: Implementarea antenei de tip horn Desenarea unui dreptunghi care va servi ca port
	Slide 17: Atribuirea surselor și a condițiilor de frontieră 
	Slide 18: Atribuirea surselor și a condițiilor de frontieră 
	Slide 19: Setarea parametrilor care se doresc a fi determinați în cadrul lucrării 
	Slide 20: Setarea parametrilor care se doresc a fi determinați în cadrul lucrării  Crearea unei sfere de radiație
	Slide 21: Culegerea, interpretarea și postprocesarea rezultatelor
	Slide 22: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea parametrilor S
	Slide 23: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea parametrilor S
	Slide 24: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea radiației
	Slide 25: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea radiației (rE)
	Slide 26: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea castigului
	Slide 27: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea castigului 2D
	Slide 28: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea castigului 2D
	Slide 29: Culegerea, interpretarea și postprocesarea rezultatelor Reprezentați distribuția de câmp electric in planul XY
	Slide 30: Culegerea, interpretarea și postprocesarea rezultatelor Reprezentați distribuția de câmp electric in planul XZ
	Slide 31: Culegerea, interpretarea și postprocesarea rezultatelor Reprezentați distribuția de câmp magnetic in planul XY
	Slide 32: Culegerea, interpretarea și postprocesarea rezultatelor Reprezentați distribuția de câmp magnetic in planul XZ
	Slide 33:      Aplicații
	Slide 34
	Slide 35:  Enunțul lucrării  
	Slide 36:  Enunțul lucrării  
	Slide 37:  Obiectivele lucrării   
	Slide 38: Implementarea modelului pentru modelare numerică 
	Slide 39: Implementarea modelului pentru modelare numerică 
	Slide 40: Implementarea antenei de tip horn Desenarea ghidului de undă
	Slide 41: Implementarea antenei de tip horn Desenarea ghidului de undă
	Slide 42: Implementarea antenei de tip horn Desenarea ghidului de undă
	Slide 43: Implementarea antenei de tip horn Desenarea unui cerc ce va servi ca port
	Slide 44: Atribuirea surselor și a condițiilor de frontieră 
	Slide 45: Atribuirea surselor și a condițiilor de frontieră 
	Slide 46: Setarea parametrilor care se doresc a fi determinați în cadrul lucrării 
	Slide 47: Setarea parametrilor care se doresc a fi determinați în cadrul lucrării  Crearea unei sfere de radiație
	Slide 48: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea parametrilor S
	Slide 49: Culegerea, interpretarea și postprocesarea rezultatelor  Reprezentarea castigului
	Slide 50
	Slide 51: Bibliografie

